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Resumo:       

O artigo se propõe a apresentar o RQDA, pacote da linguagem R para análise 

qualitativa, como uma alternativa a softwares proprietários para esse tipo de pesquisa 

que hoje são bastante populares, tais como NVivo e Atlas.ti. Em um primeiro 

momento, discute-se a trajetória dos softwares de apoio à análise qualitativa de 

dados, conhecidos pela sigla em inglês CAQDAS (Computer-assisted Qualitative Data 

Analysis Software). Em seguida, o artigo apresenta a linguagem R e o pacote RQDA, 

com instruções para a suas instalações. Por fim, a partir de exemplos, são mostradas 

funcionalidades, como a importação de arquivos e codificações, além de outras 

algumas aplicações de análise qualitativa de dados. 

 

Palavras-chave: CAQDAS. R. RQDA. análise qualitativa. 

 

Abstract:        

The article aims to present the RQDA, package of the R language for qualitative 

analysis, as an alternative to proprietary software for this type of research that today 

are quite popular, such as NVivo and Atlas.ti. First, we discuss the path of software to 

support the qualitative analysis of data, known as the CAQDAS (Computer-Assisted 

Qualitative Data Analysis Software). The article then presents the R language and the 

RQDA package, with instructions for its installation. Finally, from examples, 
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functionalities are shown, such as files import and codings, as well as some other 

qualitative data analysis applications. 

 

Key words: CAQDAS. R. RQDA. qualitative analyses.  

 

 

Introdução 

 

As tecnologias digitais se fazem cada vez mais presentes em quase todas as 

esferas da sociedade. Na medida em que essas novas tecnologias se inserem no 

cotidiano, ocorrem profundas alterações nas instituições sociais, na cultura e relações 

interpessoais. Ao mesmo tempo, todas as áreas do conhecimento também são 

profundamente alteradas, incluindo a Sociologia. (NASCIMENTO, 2016) 

Porém, a Sociologia não avançou no debate com as tecnologias digitais, 

diferente de áreas - como as Ciências Exatas e da Natureza - que foram 

profundamente transformadas por estas tecnologias. Sendo assim, torna-se 

extremamente necessária uma atualização da área, de seus pressupostos teóricos e 

fundamentação metodológica, para que seja possível lidar com esses novos fenômenos 

- tanto em quantidade quanto em qualidade (NASCIMENTO, 2016). É, então, necessário 

“reconhecer que os esforços de um eterno retorno às teorias clássicas devem vir 

acompanhados de um gradiente de reflexão de mesma magnitude em encontrar novas 

ideias e teorias que produzam inteligibilidade sobre o que está acontecendo no mundo 

social”. (NASCIMENTO, 2016, p. 231)  

Nesse intento, as ferramentas de análise qualitativa de dados com auxílio de 

computador se apresentam como elementos importantes para a sociologia no século 

XXI, devido ao grande volume de dados hoje disponíveis para análise dos cientistas 

sociais. Tais ferramentas possibilitam não apenas uma mudança de técnica (da técnica 

manual para a digital), mas, sobretudo, apresentam novas  possibilidades de ação e 

análises fundamentais para a pesquisa social.    

Porém, como já alertavam Alex Teixeira e Fernando Becker (2001) no início dos 

anos 2000, apresentar sobre as possibilidades da operacionalização da pesquisa social 

por meio de CAQDAS (softwares de apoio a análise de dados qualitativos, na sigla em 
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inglês) é um desafio pois além dos manuais de metodologia qualitativa não trazerem 

informações sobre o uso desses pacotes também são pouco difundidos no ambiente 

acadêmico brasileiro, mesmo que tenham se desenvolvido e se expandido nos últimos 

anos.  

O presente artigo apresenta uma alternativa livre e gratuita aos softwares 

proprietários de análise qualitativa de dados, o RQDA, que ainda possui pouco material 

disponível para consulta e documentação, principalmente em língua portuguesa. 

Parte-se do entendimento de que, apesar de apresentarem certas vantagens, como 

interface amigável e integração com outras ferramentas, os softwares proprietários, 

por serem pagos, muitas vezes tornam-se inacessíveis para alguns(mas) 

pesquisadores(as).  

Além disso, procuramos apresentar outras aplicações da linguagem de 

programação R, distintas das técnicas e metodologias quantitativas, que hoje são 

amplamente utilizadas por pesquisadores, apresentando uma possibilidade que 

combina linhas de comando (padrão no R) e interface gráfica, facilitando a utilização 

e compreensão do usuário. Apesar de menos difundido que softwares proprietários, o 

pacote RQDA apresenta capacidade de integração com outros pacotes quantitativos do 

R - como, por exemplo, o pacote tm para mineração de textos e o pacote QCA para 

análise qualitativa comparada - e segue a lógica dos principais softwares de análise 

qualitativa, facilitando a migração de usuários.  

Ao longo do artigo, apresentaremos algumas funcionalidades básicas que podem 

ser acessadas pela interface gráfica, bem como alguns códigos de caráter introdutório. 

Devido ao propósito introdutório do artigo, outras funcionalidades mais complexas, 

assim como as possibilidades de integração com outros pacotes, não serão discutidas 

aqui. O objetivo central desse texto, portanto, é que o leitor compreenda as 

possibilidades de aplicação da ferramenta antes de aplicá-la na pesquisa.  

 Na primeira seção deste artigo, discutiremos o percurso dos CAQDAS e 

vantagens e desvantagens de suas aplicações. A segunda e terceira seção apresentam 

a linguagem de programação R e o pacote RQDA bem como os passos para instalação. 

Na quarta seção apresentamos funcionalidades básicas e exemplos de aplicação do 

RQDA.  
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1. Análise qualitativa de dados com auxílio de computadores 

      

Desde os anos 1980, com a proliferação de tecnologias da informação, 

programas de computadores especializados em análise qualitativa - que procuravam 

aplicar os modelos analíticos já realizados de forma manual na codificação de textos - 

passaram a estar disponíveis para a comunidade científica. O primeiro software 

desenhado para este fim, o Ethnograph, teve a sua primeira versão lançada no ano de 

1985. Em 1987, é lançado o NUD*IST (No-Numerical Unstructured Data Indexing, 

Searching and Theorizing), atual NVivo, e em 1991, o primeiro protótipo do ATLAS.ti. 

(PUEBLA, 2003)  

Apesar de serem desenhados exclusivamente para este tipo de análise, inclusive 

com fundamentação na teoria sociológica2, a inclusão destes softwares na pesquisa 

qualitativa foi permeada, desde o início, por polêmicas quanto à retirada do papel do 

pesquisador na análise e por uma suposta “fetichização” da técnica (PUEBLA, 2003). 

Porém, a disseminação destes programas possibilitaram não apenas uma 

informatização de técnicas outrora utilizadas manualmente, mas também o 

desenvolvimento de novas técnicas e ferramentas que não seriam possíveis sem o uso 

de computadores (MANGABEIRA; LEE; FIELDING, 2001; NASCIMENTO, 2016). Além disso, 

facilitaram a otimização do tempo dos processos necessários para analisar 

rigorosamente os dados e forneceram uma estrutura metodológica em torno da qual os 

processos são executados (BLISMAS; DAINTY, 2003).  

No final da década de 1990 e início dos anos 2000, os CAQDAS eram ainda pouco 

disseminados. Apesar de já existirem vários softwares deste tipo, não havia ainda uma 

rede de comunicação nem uma comunidade formada para aperfeiçoamento dos 

mesmos e auxílio aos usuários, salvo algumas poucas iniciativas locais, sobretudo de 

universidades e centros de pesquisa. O alcance restrito deste tipo de software na 

época se dava pelo fato de serem mais recentes que os softwares de análise 

quantitativa e por ferramentas, como a internet, não estar ainda disseminada pela 

população, atingindo poucos usuários. É a partir das comunidades de usuários e 

desenvolvedores que é possível aperfeiçoar os softwares – verificar erros, encontrar 

soluções, criar novas ferramentas, novas compatibilidades – e auxiliar o seu uso. 

                                            
2 O ATLAS.ti, por exemplo, baseia-se nas considerações teórico-metodológicas de Max Weber e Alfred 
Schutz quanto a tipificações. 
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(MANGABEIRA; LEE; FIELDING, 2001) 

Para Puebla (2003), a inserção de ferramentas para análise qualitativa 

computadorizada ocorre do mesmo modo que, outrora, ocorreu a inserção de 

ferramentas computadorizadas para análise quantitativa. Porém, o autor salienta que 

o uso destes dois tipos de ferramentas diferenciam-se entre si. Enquanto na análise 

quantitativa assistida por computadores o dado numérico já está dado e as 

ferramentas apenas facilitam o processamento e a velocidade dos cálculos, na análise 

qualitativa assistida por computadores o dado (não-numérico) é construído ao longo do 

processo de utilização da ferramenta, embora em ambos os casos o papel do 

pesquisador seja essencial, por ter o conhecimento necessário para a interpretação e 

tratamento dos dados.  

Para Atherton e Elsmore (2007), a utilização de CAQDAS é, em um sentido 

amplo, pragmático, ou seja, as eficiências de processamento e automação dos dados 

ajudam a resolver a complexidade e a ambigüidade dos dados coletados. Porém, 

segundo os autores, os ganhos com a eficiência de processamento mascaram situações 

de pesquisa em que falta coerência entre metodologia e teoria. Além disso, 

questionam até que ponto estas ferramentas acentuam, em vez de abordarem, os 

principais desafios da pesquisa qualitativa: des-contextualização e quebra dos dados 

(disassembly). Concluem os autores apontando para a necessidade de que sejam 

consideradas as dimensões e propriedades implícitas dos aplicativos CAQDAS, 

principalmente em relação a como eles ordenam, gerenciam e codificam os dados 

para os usuários e que o seu uso pode ser útil quando pertinentes para a questão e 

abordagem de pesquisa. Entretanto, ressaltam que  deve ser considerado previamente 

as prováveis implicações para o ordenamento dos dados e, portanto, os efeitos na 

modelagem e orientação da análise e resultados da pesquisa. (ATHERTON; ELSMORE, 

2007) 

 

2. O que é o R? 

  

R é uma linguagem de programação livre para cálculos estatísticos e 
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visualização de gráficos e também um Ambiente de Desenvolvimento Integrado (IDE3, 

no inglês), com versões para os sistemas operacionais Linux, Windows e MacOS. Criada 

em 1993 pelos estatísticos Robert Gentleman e Ross Ihaka, do Departamento de 

Estatística da Universidade de Auckland, na Nova Zelândia, deriva da linguagem S - 

desenvolvida em 1972, com sua última versão lançada em 1998 - ainda utilizada no 

software proprietário S-Plus, da empresa TIBCO Software4. Posteriormente, passou a 

ser mantida em um esforço colaborativo de uma comunidade internacional, a partir da 

criação da R Foundation for Statistical Computing5. 

 O código da linguagem está disponível para download no site da R Foundation, 

assim como um repositório com diversos pacotes desenvolvido e mantido pela própria 

comunidade. Atualmente, estão disponíveis 13.515 pacotes na CRAN6 (Comprehensive 

R Archive Network), rede responsável pela distribuição do software e seus pacotes, 

sincronizados diariamente por uma rede de servidores que “espelham” o repositório 

(mirrors), sendo cinco delas localizadas no Brasil, com nove sites7.   

 Os pacotes submetidos à equipe da CRAN são revisados e posteriormente 

disponibilizados para download para os usuários. Sendo assim, qualquer usuário pode 

criar pacotes para o R de modo a automatizar funcionalidades para a linguagem. É o 

desenvolvimento e a oferta destes pacotes que possibilitam que a linguagem se 

expanda para além das utilidades que foi desenvolvida inicialmente. Desse modo, hoje 

com o R é possível implementar análises e aplicações tanto quantitativas quanto 

qualitativas, com técnicas estatísticas, produção de gráficos e imagens, análise de 

conteúdo, mineração de textos, análise de redes sociais, análise de informações 

geográficas, entre outros. Por ser de código livre, funcionar em qualquer sistema 

operacional e ter uma comunidade de usuários ativa, a linguagem foi capaz de se 

expandir, principalmente nos últimos anos, com a ascensão e popularização da Ciência 

de Dados, ainda que, no Brasil, ela ainda seja pouco utilizada na área de Ciências 

Humanas.  

Apesar de seu maior uso ser para pesquisa quantitativa, há pacotes que 

                                            
3
 Uma IDE (Integrated Development Environment) é um software que permite a utilização de 

ferramentas que auxiliam no desenvolvimento de softwares.   
4
 TIBCO. Disponível em: https://www.tibco.com/ 

5
 The R Project for Statistical Computing. Disponível em: https://www.r-project.org/ 

6 The Comprehensive R Archive Network. Disponível em: https://cran.r-project.org/ 
7 Um na Universidade Estadual de Santa Cruz, dois Universidade Federal do Paraná, dois na Fundação 
Oswaldo Cruz, dois na USP São Paulo e dois na USP Piracicaba. Para informações quanto a estatísticas 
dos mirrors: https://cran.r-project.org/mirmon_report.html 
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possibilitam a análise qualitativa, executando muitas das funções de softwares 

proprietários de CAQDAS, como o NVivo, Atlas.ti e Ethnography. É o caso do pacote 

RQDA (R for Qualitative Data Analysis) (HUANG, 2018), que mescla funcionalidades em 

interface gráfica (GUI) e em linha de comando, que será apresentado na seção a 

seguir.  

Este pacote foi criado em 2008 por Ronggui Huang, quando realizava seu 

doutoramento. Segundo relatado na documentação do pacote8, Huang procurava um 

software que tivesse funções básicas de QDA, funcionasse tanto em sistemas 

operacionais Linux quanto Windows e no qual ele pudesse ter total controle sobre as 

funcionalidades. Como não encontrou nenhuma ferramenta que englobasse todos esses 

requisitos, decidiu por implementar uma.  

Chandra e Shang (2017), apontam que a maior vantagem na utilização do RQDA 

é que a ferramenta permite ao usuário integrar outros pacotes e funções do R sendo 

possível realizar análises mistas em uma única plataforma - análises estatísticas em 

uma grande quantidade de documentos de texto, por exemplo. Uma outra, é a 

possibilidade de importar os códigos em arquivos HTML, o que possibilita o 

compartilhamento de dados entre pesquisadores.  (CHANDRA; SHANG, 2017) 

3. Instalando o R e o RQDA 

 

Para utilizar o pacote RQDA é necessário ter instalado o R no computador. A 

instalação pode ser feita seguindo o passo a passo no site da CRAN (https://cran.r-

project.org/), dependendo do sistema operacional do computador (Linux, MacOS ou 

Windows). A última versão disponível é a 3.5.1, de 2 de julho de 2018. Após a 

instalação do R, recomendamenda-se a instalação de um software de ambiente 

integrado (IDE), principalmente para usuários iniciantes, que facilita a utilização da 

linguagem. Dentre as tantas IDEs disponíveis, a mais utilizada é o software RStudio. 

Para a instalação do RStudio, é necessário realizar o download correspondente ao 

sistema operacional no site (https://www.rstudio.com/products/rstudio/download/).  

Antes de instalar o pacote RQDA, é necessário instalar a ferramenta para 

                                            
8
 HUANG, R. User’s manual. Disponível em: http://rqda.r-forge.r-

project.org/documentation_2.html#faq 

https://cran.r-project.org/
https://cran.r-project.org/
https://www.rstudio.com/products/rstudio/download/
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interfaces gráficas GTK+9. Após a instalação, deve-se abrir o R (ou o RStudio) e no 

prompt de comando inserir o seguinte comando: 

install.packages("RQDA",dependencies=c("Depends", "Imports"))10. Após a instalação do 

pacote, digite library(“RQDA”) na linha de comando do R. O R irá carregar o pacote e 

abrir uma janela, a GUI (Graphical User Interface) do RQDA. Explicaremos os passos 

iniciais e alguns conceitos básicos para utilização do pacote RQDA na seção a seguir.     

4. Como fazer análise de dados qualitativos no R 

 

No lado direito janela inicial  (figura 1), encontram-se as abas do menu do 

RQDA. A aba Project, a primeira, é a que aparece na tela inicial. Na parte inferior 

desta tela inicial é possível verificar informações sobre a versão do pacote e a licença, 

o contato do autor do pacote e um link para inscrição em uma lista de email de ajuda 

do RQDA.   

Ao clicar na opção “New Project” é criado um arquivo .rqda em seu computador 

(é possível alterar o local que será salvo) - uma base de dados SQLite11 - que armazena 

todas as informações trabalhadas, facilitando o manejo das informações. Ao criar um 

projeto novo a informação do local de armazenamento de seu projeto estará indicada 

na aba Project, em “Path of current project” (caminho/endereço do projeto atual). 

Na aba “Settings” (Configurações) algumas configurações podem ser feitas, como 

alterar a cor dos rótulos e casos. Uma configuração importante é a caixa “Name of 

coder”, onde é possível inserir o nome da pessoa que estará codificando o projeto e a 

caixa “Encoding” para alterar a codificação de leitura dos arquivos que serão 

analisados (o padrão é a codificação ASCII).    

 

 

 

                                            
9
 Usuários Windows podem acessar o link http://downloads.sourceforge.net/gladewin32/gtk-2.10.11-
win32-1.exe?modtime=1175123376&big_mirror=0. Para usuários Linux Debian, o comando: sudo apt-
get install libgtk2.0-dev. Para usuários Linux Fedora, o comando: yum install -y gtk2-devel. Para 
usuários MacOS: instalar o X11 (https://www.xquartz.org/) e GTK+ (http://r.research.att.com/). Para 
mais informações: http://rqda.r-forge.r-project.org/  

10
 Para usuários MacOS o comando é  install.packages('RQDA') 

11
 Biblioteca desenvolvida em linguagem C. Permite que programas que a utilizam possam ter acesso a 
banco de dados SQL sem a necessidade de implementar o processo SGBD, o que deixa a aplicação 
menos pesada. Disponível em: https://www.sqlite.org/about.html.   

http://downloads.sourceforge.net/gladewin32/gtk-2.10.11-win32-1.exe?modtime=1175123376&big_mirror=0
http://downloads.sourceforge.net/gladewin32/gtk-2.10.11-win32-1.exe?modtime=1175123376&big_mirror=0
https://www.xquartz.org/
http://r.research.att.com/
http://rqda.r-forge.r-project.org/
https://www.sqlite.org/about.html
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Figura 1 - Janela inicial do RQDA 

  

Fonte: RQDA (2018).  

 

Na aba “Files” (arquivos) é possível inserir todos os arquivos de textos 

necessários para a análise a ser realizada, que serão adicionados ao projeto em uso. O 

RQDA aceita arquivos de textos, o que inclui as extensões .doc, .odt, .csv, .tsv. No 

exemplo que utilizaremos neste artigo importaremos apenas dois arquivos - arquivos 

.csv com o discurso dos/as Deputados/as Federais que votaram “não” e “sim” na 

decisão do impeachment da ex-presidenta Dilma Rousseff em 17 de abril de 2016 - 

mas também é possível carregar uma lista de arquivos ou todos os arquivos de um 
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diretório. A figura 2 mostra o código para carregar todos os arquivos de um diretório, 

com a função “addFilesFromDir()” do próprio RQDA. O primeiro atributo da função é o 

caminho da pasta onde se encontram os arquivos, o atributo “pattern” é o formato 

dos arquivos. Ao rodar a função será importado para o projeto do RQDA todos os 

arquivos da pasta com a extensão informada.     

 

 

 

Figura 2 - Comando para importação de arquivos 

 

Fonte: RQDA (2018). 

 

A figura 3 a seguir mostra a tela da aba “Files”, já com o arquivo que iremos 

utilizar. Nesta tela, é possível adicionar arquivos manualmente (“Import”), criar um 

arquivo novo (“New”), e renomear um arquivo existente (“Rename”). A opção “Open” 

abre o arquivo que está selecionado em uma nova janela, onde é possível ver todo o 

conteúdo textual do mesmo.  
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Figura 3 - Janela da aba “Files” do RQDA 

 

Fonte: Elaborado pela autora. 

 

 A aba Codes12 possibilita que sejam adicionadas códigos13 nos segmentos de 

texto dos arquivos do projeto. É possível adicionar um código (code) novo, excluir ou 

renomear. Com um dos arquivos de texto abertos, selecionamos o código que 

queremos utilizar. Ao selecionar o trecho do texto que queremos que seja 

categorizado naquele code clicamos na tecla “Mark”. Assim, o trecho selecionado 

ficará incluso na categoria escolhida, agora com uma marcação antes do início do 

trecho, como mostra a figura 4. Para desmarcar o trecho, clique no código antes do 

início do trecho e clique na tecla “Unmark”. Este processo de inserir códigos nos 

textos também é conhecido como codificação (coding). Para exportar as codificações 

                                            
12 Aqui, padronizaremos a tradução de Codes para códigos. 
13

 Códigos são ”as categorias, dimensões de análise ligadas aos problemas e interesses de pesquisa. São 
“recipientes” que recebem um nome e, opcionalmente, uma definição.” (BAUMGARTEN; TEIXEIRA; 
LIMA, 2007, p. 412) 
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criadas, abra a aba “Codes”, clique com o botão direito na parte em branco da tela, 

selecione a opção “Export Codings as HTML”, irá abrir uma nova janela, onde é 

possível selecionar todas as codificações desejadas.  

 

Figura 4 - Janela de codificação do RQDA

  

Fonte: Elaborado pela autora. 

 

 Também é possível ver todos os trechos de uma codificação específica. Ao clicar 

duas vezes sob o código desejado, uma nova janela se abrirá, a quantidade de trechos 

codificados com esse código (na aba da janela), os respectivos trechos codificados, 

assim como em qual arquivo ele se encontra e qual é o intervalo de caracteres no 

texto correspondente. Nesta nova janela, é possível também desmarcar algum trecho 

ou recodificá-lo em um novo código, o que facilita caso algum trecho tenha sido 

categorizado erroneamente, não sendo necessário localizar o local do trecho.  

Para organizar os códigos (codes)  é possível criar categorias de códigos (code 

categories), na aba correspondente, no botão "Add". Depois de criar essas categorias, 

selecione uma das categorias e clique no botão “Add To". Uma nova janela irá abrir 

com uma lista de todos os códigos já criados e selecionar aqueles que deverão ser 

categorizados. Essas categorias devem ser criadas com base na pergunta de pesquisa e 

no desenho da pesquisa.  
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Digitando no prompt de comando os códigos da figura 5 (funções length() e 

getFileIds), tem-se a quantidade de arquivos associados ao projeto (linha 4), a 

quantidade de arquivos do projeto que não estão codificados (linha 5) e a quantidade 

de arquivos do projeto que já estão codificados (linha 6). Com a função 

summaryCodings(), é retornado um resumo das codificações já realizadas: quantidade 

de trechos codificado em cada código, média de caracteres atribuídos a cada código e 

número de arquivos associados a cada código (figura 6).  

 

Figura 5 - Comandos para verificação de arquivos 

  

Fonte: RQDA (2018). 

 

 Na aba “File categories”, do menu principal, é possível organizar e classificar os 

arquivos adicionados. Neste sentido, pode-se classificar as fontes/arquivos de um 

projeto de acordo com a necessidade da pesquisa. Se, por exemplo, estamos 

trabalhando com vários arquivos do mesmo tipo, podemos organizá-los entre si. Por 

exemplo, organizar as entrevistas de uma pesquisa com alunos e funcionários de uma 

escola por tipo de entrevistado (“Alunos”, “Professores”, “Funcionários 

administrativos”), ou organizar notícias de jornais pelo nome do jornal de cada uma 

delas. Se, por outro lado, estamos trabalhando com uma variedade de tipos de arquivo 

podemos criar categorias para cada tipo: “Jornais”, “Relatórios”, “Entrevistas”, 

“Leis”, etc.  
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Figura 6 - Comando e saída da função summaryCodings() 

 

Fonte: Elaborado pela autora. 

 

Para criar as categorias de arquivos é só clicar no botão “Add” na aba “File 

Categories” e ir adicionando as categorias. Para adicionar arquivos a uma categoria 

clique no botão “Add To”, uma janela com todos os seus arquivos irá aparecer, 

adicione os desejados; ou com o botão direito clique sobre o arquivo desejado e 

selecione a opção “Add to file category...", uma janela com a lista de categorias irá 

aparecer e selecione a desejada. É possível renomear ou excluir categorias criadas, 

sem que com isso altere os arquivos vinculados.  

A função casos (“Cases”) é bem próxima da função de categorias de arquivos. 

Porém, enquanto as categorias de arquivos dizem respeito à natureza do arquivo (um 

jornal ou tipo de jornal, uma entrevista ou tipo de entrevista, por exemplo), os casos 

dizem respeito a classificações internas dos arquivos. Por exemplo, podemos separar 

os entrevistados por gênero, por idade, por raça/cor, por região e assim por diante. 

Para criar um caso clique na aba (Cases) e no botão adicionar. É possível adicionar 

arquivos inteiros (clicando no botão “Add” e selecionando os arquivos desejados) ou 

trechos de textos (indo no texto e com o caso desejado selecionado, selecione o 

trecho escolhido e aperte o botão link).    

Os atributos ("Attribute"), por sua vez, funcionam da mesma forma que as 

variáveis em pesquisas quantitativas e podem ser vinculados a um arquivo ou a um 
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caso, dependendo do desenho da pesquisa que estiver sendo realizada. Atributos de 

casos dizem respeito a categorias analíticas da pesquisa enquanto os atributos de 

arquivo a categorias empíricas da pesquisa. Os atributos de arquivos podem servir para 

mostrar um subconjunto de arquivos ou para gerar estatísticas destes arquivo (por 

exemplo, informações dos entrevistados). Porém, enquanto é possível vincular parte 

de um texto a um caso, é  possível apenas vincular arquivos inteiros em um atributo.  

 É possível filtrar as informações codificadas pelos casos e pelas categorias de 

arquivo, na aba Settings14, alterando a configuração da opção “Type of Retrieval”. Se 

selecionarmos “filecategory”, filtramos os códigos e as categorias de códigos por 

categorias de arquivo. Por exemplo, se temos as categorias de arquivo “entrevistas” e 

“jornais”, ao selecionarmos entrevistas e abrirmos um código específico uma janela 

irá abrir com todos os trechos de entrevistas categorizados com aquele código. Mesmo 

se tivermos trechos de jornais categorizados com o mesmo código, esses trechos não 

irão aparecer. Essa funcionalidade é muito útil quando trabalhamos com muitas 

categorias de arquivos. Da mesma forma, se selecionarmos a opção “case” podemos 

filtrar os códigos pelos casos definidos. Assim, se definimos anteriormente nossos 

casos como “feminino” e “masculino”, ao selecionarmos um deles e abrirmos um 

código, só serão mostrados na tela os trechos marcados com o caso solicitado. Essa 

técnica chama-se “seleção condicional”. Para deixar sem nenhuma condicional na 

seleção dos códigos, deve-se voltar a opção “Type of Retrieval” para “unconditional”.  

 Por fim, ao longo do processo de codificação, duas ferramentas úteis são as 

memos e “journal”, que funcionam como anotações. Estas anotações auxiliam o/a 

pesquisador/a a lembrar das escolhas que forem sendo feitas durante o processo de 

análise da pesquisa e o que cada objeto significa, assim como informações do processo 

de pesquisa. As memos podem ser  adicionadas ao projeto, em cada arquivo inserido, 

nos atributos, e nas categorias de arquivo. Porém o tipo de memo mais importante é 

os que podem ser adicionados aos codes (e categorias de códigos) criados, pois 

durante a categorização, principalmente em pesquisas com muitas fontes em que 

muitos codes são criados, é importante manter uma anotação do que cada code 

significa. Os journals são anotações sobre o andamento da pesquisa, algo como um 

diário de campo, cada nova entrada recebe a data e o horário em que foi inserido. Ao 

                                            
14

 Sempre que alterar alguma configuração na aba “Settings”, é necessário apertar o botão “ok” para 
que as configurações sejam salvas.  
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clicar em adicionar,  uma nova janela é aberta, permitindo que sejam inseridas 

informações textuais, após salvar, o usuário pode renomear e inserir um nome para a 

entrada.  

  O quadro 1, a seguir, apresenta um resumo das rotinas apresentadas aqui.  

 

Quadro 1 - Resumo das rotinas do pacote RQDA 

Funcionalid

ade 

Descrição Rotina 

Project Local em que se trabalha todos 

os arquivos necessário para 

análise da pesquisa  

Opção 1: criar novo projeto 

Project -> New Project  

Opção 2: abrir projeto 

Project -> Open Project  

Opção 3: fazer cópia (backup) do projeto 

Project -> Backup Project  

Files Cada arquivo a ser analisado 

na pesquisa. Necessário ser 

arquivo do tipo texto 

Files -> Import 

Codes Rótulos aplicados a trechos de 

um texto/arquivo 

Passo 1: criar code 

Codes -> Add 

Passos 2: atribuir a trechos do texto 

Abrir texto -> Selecionar code -> Selecionar 

trecho do texto desejado -> Clicar em Mark 

Code 

categories 

Forma de organizar os códigos 

(codes) criados 

Passo 1: criar a categoria 

Codes Categories -> Add 

Passo 2: atribuir aos codes 

Selecionar a categoria -> Add To -> Selecionar 

codes 

Cases Permite separar arquivos ou 

trechos de um arquivo 

Passo 1: criar o caso 

Cases -> Add 

Opção 1: vincular arquivo inteiro ao caso 

Files -> Selecionar arquivo -> Botão direito do 

mouse -> Add to case -> Selecionar o caso 

Opção 2: vincular trecho do texto ao caso 

Aba Files -> Abrir arquivo -> Aba Cases -> 

Selecionar case -> Selecionar trecho do texto -> 
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Botão Mark  

Attributes Permite inserir atributos a um 

arquivo ou caso (não é possível 

vincular um atributo a um 

trecho de texto).  

Passo 1: criar o atributo 

Attributes -> Add 

Passo 2: definir tipo do atributo 

Selecionar atributo criado -> Class -> Selecionar 

opção desejada  

Passo 3: adicionar atributo a um arquivo/caso 

Selecionar atributo criado -> Files ou Case -> 

Selecionar arquivo ou caso desejado -> Botão 

Attribute -> Inserir valor do atributo -> 

Selecionar espaço em branco -> Botão Save and 

close 

File 

categories 

Classificação de tipo de 

arquivo, de uma mesma origem 

(tipos de jornais) ou de origens 

distintas (jornais, entrevistas, 

etc) 

Passo 1: criar a categoria  

File Categories -> Add 

Passos 2: atribuir aos arquivos 

Selecionar categoria -> Add To -> Selecionar 

arquivos 

Journals Anotações do processo de 

pesquisa. Auxilia na 

organização da pesquisa. 

Passo 1: criar Journal 

Journals -> Add -> Inserir informações -> Save 

Journal 

Passo 2: nomear Journal 

Selecionar Journal -> Rename -> Inserir nome 

Memo Anotações das escolhas feitas 

durante a pesquisa. Auxilia na 

organização dos 

arquivos/códigos/categorias e 

atributos. 

Opção 1: memo do projeto 

Project -> Project Memo -> Escrever informações 

-> Save memo 

Opção 2: memo de arquivo/code/categoria de 

código/atributo ou categoria de arquivo  

Aba desejada -> Selecionar objeto desejado -> 

Memo -> Adicionar informações -> Save Memo 

Type of 

Retrieval 

Filtragem por categorias e por 

casos 

Opção 1: filtrar por categoria de arquivo 

Settings -> filecategory (Type of Retrieval) -> 

botão ok -> File Categories -> selecionar 

categoria desejada -> Codes -> abrir código 

desejado 

Opção 2: filtrar por caso 

Settings -> case (Type of Retrieval) -> botão ok -
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> Cases -> selecionar caso desejado -> Codes -> 

abrir código desejado 

Opção 3: não filtrar 

Settings -> unconditional (Type of Retrieval) -> 

botão ok 

Fonte: RQDA (2018). Elaboração própria.  

 

Conclusão 

 

Este artigo apresentou uma introdução ao pacote RQDA da linguagem de 

programação R. O objetivo principal foi elaborar e disponibilizar um guia introdutório 

e resumido em língua portuguesa para alunos/as de graduação, pós-graduação, 

professores/as e pesquisadores/as que já utilizam softwares de análise qualitativa ou 

estejam interessados em aprender. Além dessa introdução, o artigo mostrou algumas 

funcionalidades do R, software geralmente utilizado para análises quantitativas, para 

metodologias qualitativas. As rotinas foram devidamente apresentadas e 

documentadas, de modo que os usuários possam replicá-las.  

Em particular, esperamos colaborar com a difusão de novas técnicas e 

ferramentas informacionais para as Ciências Sociais, visando a abertura de novas 

possibilidades de análises e perspectivas metodológicas.        
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